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Book Descriptions:

canon bjc 2110 manual

Paper Handling. Paper and Other Print Media Notes on Handling Print Media Setting the Paper
Thickness Lever Printing on Special Media Types Printing Photographs. Using BJ Cartridges. Using
the Macintosh Printer Driver. Using the Optional IS22 Color Image Scanner Cartridge. Welcome
Printer Documentation How to Use This Manual Copyright Disclaimer Trademarks FCC Regulations
Canadian Radio Interference Regulations Safety Precautions. Introduction. A detailed
troubleshooting section provides stepbystep guidance for identifying and solving printing problems.
This Users Manual provides complete explanations of the features and functions of the printer. This
manual uses the following symbols depending on the computer system you are using. Always
observe the instructions indicated by these symbols. Windows. Use this button when you wish to
enlarge the screen you are viewing. Select this button in the tool bar, and then click within the
screen of the Users Manual. This column displays a table of contents for the Users Manual. Click the
desired item to jump to the topic. Disclaimer. Canon Computer Systems, Inc.Print Planet is a service
mark of Canon Computer Systems, Inc. Microsoft and Windows are registered trademarks of
Microsoft Corporation in the U.S. and other countries. FCC Regulations. Use of shielded cable is
required to comply with Class B limits in Subpart B of Part 15 of FCC Rules. When you are carrying
the printer, always use both hands and hold the printer by both ends. I Power Supply and Power
Cord. The socketoutlet shall be installed near the equipment and shall be easily accessible. Call the
Canon Customer Care Center. Getting Help From Canon electric shock. Always unplug the printer
from the power outlet when you are cleaning the printer. If you mistakenly plug in the printer modify
the printer. There are no user serviceable parts inside the printer. The printer contains moving parts
that could cause injury.http://dodatnagarancija.com/userfiles/dodge-caliber-2007-repair-manual.xml
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Do not subject BJ cartridges or ink tanks to shocks or excessive vibration. This could cause the ink to
leak out and stain your clothing or the surroundings. Do not touch the metal contacts on a BJ
cartridge after printing. Examining the Printer Printing Your Document Loading Plain Paper. Basic
Printing Procedures. I Front View. RESUME Button After you have resolved a sheet feeding
problem, press this button to resume printing. You can also press this button twice to start a Nozzle
Check Pattern. Avoid unplugging the printer and opening the front cover unnecessarily as print head
cleaning consumes ink. I Back View. Parallel Interface Connector Connect the printer cable here and
connect the other end of the printer cable to your computer. Paper Thickness Lever Adjust the gap
between the print head and the paper. Set this lever for the type of media that you are using.
Cartridge Holder Holds the BJ cartridge or the optional IS22 Color Image Scanner Cartridge. For
Windows users For Macintosh users. For Windows users Open the Printer Properties dialog box.
WindowsUsing the Windows Printer DriverBasic Printing Procedures. WindowsClick the OK button.
Printing begins. Click Here. If an error occurs, the BJ Printer Status Monitor displays the cause of
the error and a solution. The BJ Printer Status Monitor also detects the remaining ink in the BJ
cartridge and displays a warning message when the ink is low. Macintosh. For Macintosh users
Select the command used for printing to open the dialog box. Normally select Print or Page Setup
from the File menu.Using the Macintosh Printer Driver. Click the Print button. Printing begins. The
following screen appears during printing. When a single Macintosh computer is connected to the
printer, and while printing from the print server in a network environment, the print progress is
displayed. This section describes how you load plain paper.Paper Output Tray. Note. The paper
output tray can be raised while you are not
printing.http://gospel-pour-100-voix.com/fichiers/newsletter/dodge-caliber-2007-repair-manual-pdf.x
ml
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Load Limit Mark. Print Side. Paper Guide. Paper and Other Print Media Notes on Handling Print
Media Setting the Paper Thickness Lever Printing on Special Media Types. I Ordinary Paper. You
can also use Canon Bubble Jet Paper. You can print on both sides of the sheet. To obtain the highest
quality reproduction of photographs, use this media with the BC21e Color BJ Cartridge. To avoid
paper jams and other problems, do not use transparencies intended for use with other Canon BJ
printers, laser printers, or photocopiers. Before you execute a print job, open the printer driver and
select the settings that match the media loaded in the printer. Using the Windows Printer Driver
Using the Macintosh Printer Driver. I Paper Handling Guidelines. If this occurs, move the paper
thickness lever to the right. I Media Sizes. Set the paper thickness lever to match the media type.
Paper Thickness Lever. Artist Canvas Back Print Film Banner Paper Glossy Photo Cards Glossy
Photo Paper Greeting Cards High Gloss Film High Resolution Paper Magnet Sheets Transparencies
TShirt Transfer Envelopes. Windows Macintosh. Selecting the BJ Cartridge and Media Type
Changing the Print Dialog Box Settings. A maximum of six sheets can be printed at one time. In this
case, tear off seven sheets. Printing Side. For Windows, the Banner Printing option is on the Page
Layout tab. For Macintosh, the Banner Printing option is in the Page Setup dialog box. See the
instructions on the Loading Support Sheet for details. Loading Support Sheet B Printing Side Glossy
Side. Do not use Loading Support Sheet A, which is also included in the Glossy Photo Paper package.
I High Resolution Paper. This paper provides superior color development. However, if the printed
paper curls, or ink does not dry quickly, remove each sheet as it comes out of the printer. I Magnet
Sheets. Plain paper Glossy side of Magnet Sheet. You must select TShirt Transfer as the Media Type
for the image to be reversed.

I EnvelopesAlso, make sure the BC22e Photo BJ Cartridge is installed. Load special print media in
the auto sheet feeder of the printer.For Windows users For Macintosh users. For optimum
reproduction of all the color tones, make sure that the Media Type setting is correct for the media
you have loaded in the printer. For Windows usersWindowsTypes of BJ Cartridges BJ Cartridge
Guidelines Replacing Ink Tanks Replacing the BJ Cartridge. Select the BJ cartridge that best meets
your particular print job. I BC21e Color BJ Cartridge included with printer. Use this BJ cartridge for
standard highquality color printing. BCI21 Color Ink Tank BCI21 Black Ink Tank. BJ Cartridge
Without Ink Tanks. The following BJ cartridges consist of a print head and ink tank sealed in one
unit. When this BJ cartridge runs out of ink, discard the entire print head unit. I BC20 Black BJ
Cartridge optional. I When to Replace the BJ Cartridge. When your printed text is faint or the
printed colors are wrong, print a Nozzle Check Pattern and check the status of the print head. BC20
Black BJ Cartridge BC22e Photo BJ Cartridge. BC21e Color BJ Cartridge. Printing a Nozzle Check
Pattern Cleaning the Print Head Replacing Ink Tanks Replacing the BJ Cartridge. When you
purchase extra ink tanks, specify the BCI21 Color Ink Tank or BCI21 Black Ink Tank. Make sure the
printer is connected to the power outlet.Using BJ Cartridges. Using BJ CartridgesUsing BJ
CartridgesNote. Always hold the BJ cartridge by its sides. Never touch the silver plate, print head, or
the sharp edges around the print head.Remove the orange protective cap and tape. Protective Cap.
Protective TapeThen lower the cartridge lock lever until it locks into place. Setting the Paper
Thickness LeverNote. Using the Windows Printer Driver. For instructions on installing the printer
driver, refer to the Quick Start Guide. Youll also want to use the online Help to learn more about the
functions of the printer driver. Using Online Help.
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I From Your Application Program. You can open the Printer Properties dialog box from your
application program before printing.Using the Windows Printer DriverIf another printer name is
displayed, click the downarrow and then select Canon BJC2100 from the pulldown list. Using the
Windows Printer DriverThe Printer Properties dialog box opens. Using the Windows Printer
DriverPoint to Settings, then click Printers. When the Printers window is displayed, click the Canon
BJC2100 icon. When you open the Printer Properties dialog box directly from the Start menu, some
other tabs such as General and Details are added by the Windows operating system. For more
details on these additional tabs, refer to your Windows documentation. Gives priority to print speed
rather than print quality. Use this print mode for trial printing. BJ Cartridge Color Media Type Plain
Paper. Color. Plain Paper. Select the desired icon according to your print purpose in the Choose
Print Mode box. Make sure that the BJ Cartridge and Media Type settings match the BJ cartridge
and print media installed in the printer. Current Setting. Make sure that Page Size is identical to the
setting in the application program before printing. Print Settings Information Box. If this information
is not correct, click on the Page Layout tab and make the correct selections. I Changing the Page
Size for standard paper sizesClick the downarrow in the Page Size box, then select the appropriate
page size from the pulldown list. I Changing the Paper Size for custom paper sizesClick the
downarrow in the Page Size box, then select Custom Size from the pulldown list. The Custom Page
Size dialog box is displayed. Using the Windows Printer DriverUsing the Windows Printer Driver.
Manual Feed is not available for the BJC2100. Only Auto Feeder is provided. Use the online help to
learn about all the features of your printer driver. I Finding Information on a Particular TopicUsing
the Windows Printer DriverClick the OK button.
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The print settings become enabled and the Printer Properties dialog box closes. Printer Driver
Basics Selecting a Printer Driver Changing the Page Setup Dialog Box Settings Changing the Print
Dialog Box Settings Using Balloon Help Using Background Printing Using the Printer With a
Network. Using Balloon Help. I Selecting the Printer Driver Using ChooserThe Chooser is
displayed.Close Box. Click OnYou can now use the BJC2100 for printing. In your application, open
the Page Setup dialog box and select the paper size you are using with your printer. I Selecting the
appropriate paper size from the popup menu. Depending on the application, more options may be
displayed. For more details, refer to the Users Manual for your application program.Normally, click
Print from the File menu, and the Print dialog box is displayed. Using the Macintosh Printer
DriverNote. Click the up or downarrow to display a popup menu. Intended for printing photographs
and other graphics that use gradations of color and Tone. Allows you to customize the print mode
settings.Select Preview as the output destination, and click the OK button. Using the Macintosh
Printer DriverThe Preview dialog box is displayed. Using the Macintosh Printer DriverSelect PICT
File as the output destination, and click the OK button. Using the Macintosh Printer DriverUsing the
Macintosh Printer Driver. Position the pointer over the desired item to display a balloon help
explanation.Display the printer driver screens the Page Setup dialog box, the Print dialog box, and
so forth. I Displaying the BJ PrintMonitor Window. I Closing the BJ PrintMonitor Window. When you
select Close Status Window from the File menu, the BJ PrintMonitor window closes. Shows
information on the document currently being printed. Lists the names of the queued documents.
Click the name of the document you want to suspend printing and then click the icon. To restart
printing, click the icon.
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On the print server, select the printer driver called BJC2100.Using the Macintosh Printer
DriverSetting up client machinesSelect the BJC2100 Server icon and select the print server in
Connected to.Using the Macintosh Printer Driver. Starting the BJ StatusMonitor Doubleclick the BJ
StatusMonitor icon in the BJ Extra folder. If AppleTalk Zone is set, select a zone that includes a print
server on which you can check printing progress. Closing the BJ StatusMonitor window Select Quit
from the File menu to close the BJ StatusMonitor. Displays information related to the document
currently being printed. Select the desired print server from Print Server and then click the OK
button. You can then switch the display of the BJ StatusMonitor. Cleaning the Printer Printing a
Nozzle Check Pattern Cleaning the Print Head Cleaning the Paper Feed Rollers Transporting the
Printer. Maintaining the Printer. The inside of the printer may become soiled with ink and paper
dust as the printer is used.If you have been using the printer, wait at least one minute before
proceeding. Open the front cover and wipe inside the printer with a clean dry cloth. Look for
sprayed ink, paper dust, or scraps of paper especially around the platen. Avoid touching parts inside
the printer such as the cartridge holder. Platen. Caution. Make sure that the printer is plugged in
and more than one sheet of plain paper is loaded in the printer. For Windows users For Macintosh
users The following sections describe how to print the Nozzle Check Pattern using your printer
driver. For Windows users Open the Printer Properties dialog box, then click the Maintenance tab.
Click the Nozzle Check Pattern icon in the Test Prints box.Macintosh. For Macintosh users Select
Page Setup from the File menu, then click the Utilities button.Maintaining the PrinterBC21e Color
BJ Cartridge or BC22e Photo BJ CartridgeMaintaining the Printer. Cleaning the print head clears the
nozzles.

Cleaning the print head consumes ink so clean the print head only when necessary. Make sure that
the printer is plugged in. The following sections describe how to start print head cleaning from the
printer driver. For Windows usersSelect the print head cleaning icon in the Print Head Cleaning
box.For Macintosh usersMaintaining the PrinterThe Cleaning begins. Completion takes
approximately 30 seconds. If you frequently print on specially coated paper, like High Resolution
Paper, paper dust will accumulate inside the printer and may adversely affect paper feed. To prevent
this, clean the feed rollers using the cleaning sheet provided in the packet of coated paper.Start
cleaning. Open the Printer Properties dialog box, click the Maintenance tab and then click the clean
paper feed rollers icon.Do not reuse a cleaning sheet. MacintoshMaintaining the PrinterStore the
removed BJ cartridge in the SB21 Ink Cartridge Storage Box. Remove the paper rest and the paper
output tray from the printer. Unplug the power cord from the power outlet.Also, disconnect the
power cord from the printer.Tape. Maintaining the PrinterNote. Printout Is Unsatisfactory Printer
Does Not Start or Stops Midjob Paper Jams or Does Not Feed An Error Message Appears Other
Problems Before You Call for Help Getting Help From Canon. Troubleshooting. Replacing the BJ



Cartridge CHECK 2 BLACKWindows MacintoshIf the wrong printer driver one that supports only
monochrome printing is selected, all the documents are printed in monochrome. A clogged or worn
BJ cartridge may cause printing problems. Print a Nozzle Check Pattern and check the printed
patterns. Printing a Nozzle Check PatternAlso make sure that the BJ Cartridge and Media Type
settings match the BJ cartridge and media currently set in the printer. WindowsPrint a Nozzle Check
Pattern and check the results. Clean the print head when the patterns are broken or missing.
Printing a Nozzle Check Pattern Cleaning the Print Head.

http://www.a-fairys-choice.com/wp-content/plugins/formcraft/file-upload/server/content/files/162710
71bd8c13---bowflex-xtreme-se-exercises-manual.pdf

Open the printer driver dialog box and select the print mode best suited for the print job in the
Choose Print Mode box under the Main tab. Also make sure that the BJ Cartridge and Media Type
settings match the BJ cartridge and media currently set in the printer. Doubleclick the BJC2100 icon.
If you see one or more print jobs queued for printing, select Purge Print Documents from the Printer
menu. For details, see your Windows documentation or online Help. TroubleshootingMeaningless
characters and symbols may print if you have selected the wrong printer driver for the print job.
Before You Call for Help. Select Portrait to print across the width of the page and select Landscape
to print across the length of the page. Open the printer driver dialog box and set the correct printing
direction. TroubleshootingRefer to the printer driver online help for more details. Refer to the
printer driver online help for more details. Opening the Printer Properties Dialog Box Changing the
Page Setup Dialog Box Settings. If the setting is not correct, click the downarrow and select the
correct media from the pulldown list. The Media Type setting must match the media loaded in the
printer for the print job. Windows MacintoshRefer to the printer driver online help for more details.
TroubleshootingSet the same Page Size setting for the application program and the printer driver.
Open the Printer to the documentation of your application program. If the protective tape or cap has
been reattached, remove it. Install the BJ cartridge in the printer and clean the print head
immediately. After cleaning the print head, if printing is patchy or streaked replace the BJ cartridge.
TroubleshootingReplacing the BJ Cartridge CHECK 2 IS PRINT QUALITYMacintoshIn the Quality
panel, drag the slide bar to the right to select Fine. I Printed Pages Curled. As printed pages are
ejected from the printer, they are curled or wavy.

A lower intensity setting uses less ink thus preventing curling of the printed page. WindowsPrintouts
may be stained by excess ink inside of the printer. Cleaning the Printer CHECK 2 IS. In the printer
driver, set Print Quality to Fine. The Fine setting reduces the tendency for ink to spread in printing
color documents that require large amounts of ink, and reduces the tendency for ink to spread
where black areas are adjacent to colored areas. WindowsCleaning the Print Head CHECK 4 ISIf you
execute a high density print job on plain paper, the paper may absorb too much ink and curl, and the
print head may scratch the surface of the curled page. Lower the Intensity setting. WindowsNote. If
the Nozzle Check Pattern prints normally, there may be a problem in the application program. For
details, refer to the documentation of your application program.This reduces uneven coloration you
may see in a document where a large amount of ink is used. WindowsWindowsClick the Advanced
button in the Main tab. In the Halftoning box under the Quality tab, disable Auto if it is checked and
enabled. Click Diffusion and click the OK button. MacintoshA loose connection can cause losing part
of a print job. TroubleshootingYou may not be able to print correctly with a WPS Windows Printing
System driver installed in your system.Gradation appears streaked.In the printer driver, you can
adjust the color tones of the image by changing the density of each color cyan, magenta, yellow and
black. For example, you can lower the magenta setting when the reds are too dark or raise the cyan
setting when the blues are too light. When using Manual for Printing, click the Details button. Click
the Color panel. Move the slide bars of the individual colors to the left or right.MacintoshWhen using
Manual for printing, click the Details button. Select the Color panel. Specify the Matching Method

http://www.a-fairys-choice.com/wp-content/plugins/formcraft/file-upload/server/content/files/16271071bd8c13---bowflex-xtreme-se-exercises-manual.pdf
http://www.a-fairys-choice.com/wp-content/plugins/formcraft/file-upload/server/content/files/16271071bd8c13---bowflex-xtreme-se-exercises-manual.pdf


setting. If Output Style is grayed out and cannot be used, check Matching Method in the checkbox.

If the other device operates normally, the power outlet is functioning normally. If you perform these
checks and the problem is not solved, unplug the printer and contact the Canon Customer Care
Center. Before You Call for Help Getting Help From Canon. TroubleshootingA faulty or loose
connection can prevent it from starting. Checking the Printer and Computer Connection. If BJC2100
does not appear in the list, you must install the printer driver.Click the Details tab and select LPT1
or USBPRNnn in the Print to the following port box LPT1 Canon BJ LPT Printer Port. Opening the
Printer Properties Dialog Box. TroubleshootingPrinting a Nozzle Check Pattern Cleaning the Print
Head If the problem is not solved, replace the ink tank or the BJ cartridge.When this happens, the
cartridge holder stops moving to protect the print head. Wait about 15 minutes for the print head to
cool. If the reinstalled cartridge holder still does not return to the starting position, install another
BJ cartridge. Replacing the BJ Cartridge If the problem still persists, there may be a fault in the
printer. Contact the Canon Customer Care Center. Getting Help From Canon. Replace the printer
cable and try again. On the Windows desktop, click the Start button, point to Settings, and click
Printers. When the Printer window opens, click the BJC2100 icon to highlight it. Select Set As
Default from the File menu. Select Chooser from the Apple menu. Select BJC2100. Paper Does Not
Feed From Auto Sheet Feeder Envelopes Do Not Feed Paper Skewing During Feeding Multiple
Sheets Feed Together Paper Jam. Notes on Handling Print Media CHECK 3 ISNotes on Handling
Print Media. TroubleshootingTroubleshooting. The paper guide must be snug against the side of the
stack and not too tight.Notes on Handling Print Media CHECK 3 ISThe paper guide must be snug
against the side of the stack and not too tight. The number of sheets you can load in the auto sheet
feeder depends on the media you are using.

The media does not feed correctly if you exceed the prescribed number of sheets. CHECK 3 ISClose
the front cover, load the paper, and then print again.Notes on Handling Print Media. Error Writing
to LPT1 or USBPRNnn. Windows Windows. Application Error, General Protection Fault Other Error
Messages. Check the connections of the printer cable at the computer and the printer. CHECK 3
ISAn error will occur if this item is disabled. Read the message under Device Status and verify that a
problem is not indicated. Note what is displayed on the General tab.Uninstall the printer driver and
install it again. TroubleshootingUse a Windows 98 or Windows 95 compatible application
program.Troubleshooting. There may be a problem with the printer driver. Uninstall the printer
driver and install it again. I Other Error MessagesWhen an error occurs, the BJ Status Monitor
screen opens. Checking the Printing Environment. Printer driver could not be found. Uninstall the
printer driver and reinstall it. Background printing failed. Restart Windows and try again. Refer to
the Users Manual for your computer for information on installing additional memory. Installed
printer driver not operating correctly. Remove the installed BJ printer driver and then install the
printer driver again. Make sure that the printer cable is securely fastened to the computer and the
printer. If the problem cannot be solved, check the settings in Chooser.Click the BJC2100 icon.
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